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Abstract. Additive Manufacturing (AM) allows unprecedented design freedom, which can be

explored by the Topology Optimization (TO) algorithm. Their interplay allows a new engineer-

ing cycle with the potential to design and manufacture disruptive concepts. Thus, a systematic

methodology for designing AM parts is presented, being the main goal of this study. The

methodology is subdivided into several phases, each phase contains several tasks. Moreover,

the data flow between phases is considered and solutions are provided. Finally, the methodol-

ogy is applied to a space case study and preliminary results of the AM engineering cycle (TO,

part design and structural analysis) are depicted.

1 INTRODUCTION

“Additive Manufacturing (AM) is a process of joining bulk raw materials to make parts from

3D model data, usually layer upon layer, as opposed to subtractive manufacturing and formative

methodologies. It is an inherent part of the parts development or production process. It is used

to manufacture prototypes and production parts” [1]. Moreover, this process provides great geo-

metrical freedom and the tools to explore the referred freedom are needed. The search-optimal

material layout can be performed by Topology Optimization (TO) and its interplay with AM

has proven to be advantageous [2]. In the space industry, there are successful examples, where

the interplay of TO and AM allow the reduction of the number of parts, assembling operations,

mass and, therefore, cost (e.g. [3, 4]). Beyond that, the new technology opens a new dimension

of design solutions by overcoming the restrictions of conventional manufacturing processes.

The adopted engineering cycle consists in topology optimization (e.g. MSC Nastran R� tool for

an initial design), manual CAD1 construction (e.g. CATIA V5 R�), structural analysis and pro-

duction (process preparation and manufacturing). However, manual CAD reconstruction is

ineffective. In the one hand, TO commonly produces complex geometries that are labour in-

tensive to reproduce in CAD software. On the other hand, the TO design can be simplified in
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order to allow a rapid CAD model construction with a performance cost. Thus, in this work,

the presented methodology proposes an alternative methodology to the manual CAD model

construction, which allows for a quicker engineering cycle. Moreover, this paper proposes a

systematic methodology of a complete engineering cycle for space AM part. Furthermore,

a space case study is presented, where the topology optimization, part design and structural

analysis are presented and discussed. Finally, the main goal of this article is the methodology

systematization for designing AM parts. Therefore, this work can provide valuable guidance

for new engineers working in this field.

2 Methodologies

The complete engineering cycle of AM structures involves numerous steps. Figure 1 depicts

the whole process of designing structures within framework subsystems structures of the space

industry. For the sake of clarity, the process is illustrated as a linear flow, but iterative work

between steps is expected to originate a non-linear flow.

2.1 Topology optimization

Topology optimization is a type of structural optimization that seeks the optimum material

layout [5]. Within the scope of this work, solver 200 from MSC Software [6] was used to

perform the Topology Optimization (TO) analysis, considering compliance minimization with

a volume constraint. The referred solver uses the well known Solid Isotropic Material with

Penalization (SIMP) method and the process starts with initial domain definition [6, 7]. Within

the scope of this work, the domain is meshed using isoparametric HEX8 elements. The mesher is

available on a Patran utility named Regular Cube Mesher 2. After application of the boundary

conditions, objective, constraint and design/non-design domains definition, the optimization

cycle can start. After convergence, the resultant material distribution would ideally be a binary

distribution (void or solid material) across the design domain. However, the SIMP model uses

a continuous function and some intermediate densities may remain after convergence. These

intermediate densities have to become either void (zero) or solid (one) and, thus, the user has to

define the threshold. At the end, all solid elements become the optimized topology. Using the

referred topology, the skin elements are extracted using the utility named Skin Solid Elements.

Then, the resultant QUAD elements are broken into TRIA elements and the surface STL mesh is

exported using the export STL utility.

2.2 Smoothing and Part Edition

The smoothing operation can be done within Patran R© with limited options. Within the scope of

this work, the Netfabb R© from Autodesk R© is used to perform all the smoothing, remeshing and

repair operations. The translation between the surface STL mesh to a volume TET mesh is not

possible in Netfabb neither in Patran. The free software named GMSH [8], is used to make the

referred translation, being a straightforward procedure2. A Nastran input file is a GMSH output,

which can be imported in Patran.

2GMSH list of instructions: File>Merge>*.STL; Geometry>Add>Volume; Mesh>3D; File>Export>*.bdf
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Figure 1: Engineering cycle of AM structures for the space industry.

2.3 Structural Analysis

In the space industry, the structural analysis involves at least static loads, minimum stiffness

and sinusoidal/random vibration loads. Due to the typical slenderness of the designs, buckling

verification is also performed. The static loads are analysed with MSC Nastran solver 101

using inertial loads [9]. The minimum stiffness requirement is verified using the MSC Nastran
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solver 103 (normal modes analysis) [10], where the first eigenvalue should be above a defined

limit. The sinusoidal vibration analysis is verified using the MSC Nastran modal solver 111

(Lanczos solver: frequency response) [10], considering modal damping. The random vibration

is a two-step analysis. First, the frequency response analysis is performed for sinusoidal loading

conditions at a sequence of frequencies. Typically, these loads are chosen to be unit loads. Thus,

the output response works as a transfer function. The second step uses the referred function in

order to compute the amplified random response. A quality factor of 400, a 3σ analysis and

a log-log integration are considered. Additionally, the load levels are quantified in terms of

Power Spectral Densities (G2/Hz) [10]. Finally, the buckling verification is performed with

MSC Nastran solver 105 using equivalent inertial loads derived the most severe load case [9].

2.4 Process Preparation and Simulation

The process preparation can be performed with some software such as Netfabb R©. The first step is

the optimization of the build direction, where several orientations are considered and classified

in terms of different criteria (e.g. ratio between area and volume of support structures and/or

height and volume of the build). The second step is the support structures generation, which

can be generated by different available algorithms. Finally, the simulation of the build layer

by layer can be also simulated in order to predict residual stress, distortions and some defects

such as support structures failure or recoater interference or hot/cold spots. For instance, the

Simulation Utility for Netfabb can be allegedly used to make such predictions [11]. Moreover,

the software also performs the stress relief (viscoplastic analysis) and part response to the cut-

off from the base. This integrated procedure allows the prediction of the part total distortion

and excessive distortion on the part may lead to failure of dimensional tolerances. Thus, the

process simulation can be used to apply a negative distortion on the part in order to minimize

distortions and overbuild.

2.5 Manufacturing

The manufacturing stage shall start with the slicing operation of the prepared part and the G-

Code generation, which can be performed in Netfabb, for example. After construction, the

part shall be stress relieved, in order to decrease residual stress. Then, the part can be cut off

from the baseplate and the cleaning/smoothing process (e.g. sandblasting) can be performed.

The interfaces with tight tolerances are typically machined. Regarding quality control, the non-

destructive inspection campaign can take advantage of methods such as computed tomography,

eddy current testing, infrared thermography, neutron diffraction and ultrasonic testing [12].

Finally, the testing campaign involves static, sinusoidal and random testing, where the structure

shall survive without deterioration. The deterioration detection can be performed with a low-

intensity sinusoidal vibration sweep before and after each vibration test. If the response curve

of the low-intensity sine sweeps (before and after each vibration test) are identical, no major

structural deterioration will occur. The success criteria can be defined by a maximum shift of

5% and 20% for frequency and amplitude, respectively [13].
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3 Case Study

The structure responsible for supporting the lens for a space instrument is analysed, named as

Large Lens Mount (LLM). Titanium alloy (TI6Al4V) shall be its manufacturing material and

I/F to its supporting structure is composed of six bolted connections. This use case was derived

from a use case of OHB Sytems at Oberpfaffenhofen.

3.1 Topology Optimization and Smoothing

The design domain was discretised with linear isoparametric HEX8 elements and the transition

between the solid elements and the bolted connection centre point is modelled with rigid con-

nection (RBE2). The connection between the lens (reduced to a point element) and the solid

elements are modelled with RBE3, where the master nodes of volume mesh connects to a slave

node on the len’s CoG location (see Sub-figure 2(a)). The RBE2 element was not used, because

it adds stiffness to the model. In fact, the interface region of the lens would become rigid and

the TO algorithm would take advantage of the referred fact, leaving the interface poorly rein-

forced or the user would add to include it in the non-design domain (defeating the propose of

the TO algorithm). Regarding loading conditions, the acceleration levels were replaced by an

equivalent force on the len’s node. Finally, the TO was performed and its objective function

consists in the compliance minimization of the LLM structure, when loaded in directions X, Y

and Z (weighted sum of three static load cases).

Sub-figures 2(b), 2(d), 2(f) and 2(h) describe the TO results for the volume constraints of

40%, 20%, 10% and 5%, respectively. Sub-figures 2(c), 2(e), 2(g) and 2(i) show the resultant

smooth surface mesh after smoothing in Netfabb. Preliminary analysis on the designs of Sub-

figures 2(c) and 2(e) revealed a design overestimation for the considered loading conditions.

On the other hand, a visual inspection of the design of the Sub-figure 2(i) indicates high level

of risk from the manufacturing point of view. For instance, the removal of referred support

structures could lead to fracture of the thin members of the referred part. Therefore, the design

of the Sub-figure 2(g) was selected and it weights 0.628 kg, which is compliant with the mass

requirement. In order to facilitate the previous assessment, the model of the Sub-figures 2(g)

and 2(i) were prototyped in PLA for part visualization proposes only. The Figure 3 illustrates

the referred prototypes.

3.2 Structural Analysis

The design domain, Sub-figure 2(g), was discretised with isoparametric TET10 quadratic ele-

ments [9] and the transition between the solid elements and the bolted connection center point

is modelled with a rigid connection (RBE2). The connection between the lens and the volume

mesh is modelled as RBE2 and the lens is modelled as a lumped mass (see Sub-figure 4(a)).

In contrast with the TO analysis, the structural analysis uses RBE2, since the lens adds some

stiffness and the main goal is a correct distribution of stress maps.

Table 1 lists the first ten eigenvalues of the LLM with its modal effective mass fraction

for the translation (TX, TY, TZ) and rotational (RX, RY, RZ) degrees of freedom. . Within the

scope of this work, only the first three modes are in excitation range and, thus, only these are
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considered in analysis of the LLM. It should be noted the relevant level of coupling between

the first three modes, meaning that an excitation in a given axis is likely to activate all modes in

excitation range. The sine vibration excitation range (up to 100 Hz with 47 G in plane and 36 G

out of plane) are far from the first eigenvalue (1461.9 Hz) and, thus, the sinusoidal vibrational

analysis should be approximated to a static analysis since no relevant dynamic amplification

is foreseen. The random vibration is likely to activate the first three modes and, thus, their

dynamic amplification should be estimated. The direct responses for the X, Y and Z directions

are shown in Sub-figures 5(a) and 5(b), considering the lens node as the monitoring point and

quality factor of 400. As expected, all three modes appear in the excitation directions and their

magnitude is directly related to their modal effective mass fraction.

(a)

(b) (c)

(d) (e)

(f) (g)

(h) (i)

Figure 2: Discretisation of design domain in Sub-figure (a). Sub-figures (b), (d), (f) and (h) are topology optimi-

sation results for 40%, 20%, 10% and 5% of volume fractions, respectively. Sub-figures (c), (e), (g) and (i) depicts

the smooth surface meshes of the respective volume fractions.
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(a) (b) (c) (d)

Figure 3: The LLM physical model printed in a dummy material (PLA). Sub-figures (a) and (b) are the design

resultant from 5% of volume constraint, while Sub-figures (c) and (d) are the design resultant from 10% of volume

constraint.

Table 1: List of the first ten eigenvalues of the LLM with its modal effective mass fraction for the translation.

Mode Frequency (Hz) TX TY TZ RX RY RZ

1 1461.9 0.134 0.762 0.034 0.036 0.038 0.615

2 1580.0 0.757 0.152 0.014 0.014 0.009 0.178

3 1913.3 0.039 0.018 0.731 0.640 0.650 0.045

4 3142.8 0.003 0.003 0.018 0.036 0.010 0.001

5 3303.0 0.008 0.005 0.000 0.000 0.013 0.013

6 3447.1 0.000 0.006 0.003 0.000 0.001 0.001

7 3920.5 0.003 0.000 0.006 0.016 0.008 0.000

8 4173.8 0.002 0.001 0.002 0.030 0.000 0.001

9 4401.5 0.000 0.000 0.003 0.001 0.001 0.059

10 4641.9 0.001 0.001 0.039 0.002 0.009 0.008

Sub-figures 4(b), 4(d) and 4(f) depicts modal shapes of the first three eigenvalues values of

the LLM. While, Sub-figures 4(c), 4(e) and 4(g) describe the static stress levels (von Mises)

from the sinusoidal vibration loads and Sub-figures 4(h), 4(j) and 4(l) depict the Root Mean

Square (RMS) of the stress levels (von Mises) from the random vibration loads. Due to the slen-

derness of the structure, buckling analysis are also presented and its inputs loads were derived

from random vibration analysis. Each load case of the random vibration analysis originates

a buckling load case, where the indirect and direct responses are used to compute equivalent

quasi-static accelerations. The buckling stability factor is presented in Sub-figures 4(i), 4(k)

and 4(m).

The minimum stiffness requirement is reached with the first eigenvalue at 1461.9 Hz when

compared with 400 Hz requirement. The geometrical stability (buckling) has a relevant positive

margin. The stability factor (MSC Nastran result output) should be superior to one, otherwise,

the solver is predicting failure. The current design of LLM has a stability factor of 2560.9 (3).

Regarding strength margins, the yield stress of the Ti6Al4V should be at least 825 MPa [14]

and the maximum stress levels expected from the analysis is 40 MPa, leaving the margin for fur-

ther optimization (in theory). However, due to manufacturing risk, the compliance minimization

with a lower volume fraction constraint (see Sub-figure 2(i)) is not used.

3If the factor was dangerously closer to one, a knock-down factor analysis needed to be performed due to

analysis uncertainty.
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(a)

(b) (c)

(d) (e)

(f) (g)

(h) (i)

(j) (k)

(l) (m)

Figure 4: (a) FE modal analysis of the optimized LLM. Sub-figures (b), (d) and (f) are the modal shapes of first

three eigenvalues. (c), (e) and (g) are the static von Mises stress maps when loaded in direction X, Y and Z,

respectively. Sub-figures (h), (j) and (l) are the von Mises RMS values of the random vibration when exited in X,

Y and Z directions, respectively. Sub-figures (i), (k) and (m) are the first buckling mode when loaded in directions

X, Y and Z, respectively. All stress maps are in Pa.
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Figure 5: Random vibration responses. Sub-figures (a) and (b) are the in plane response and out of plane response,

respectively.

4 Concluding remarks

A systematic methodology for designing AM parts is conceptually presented in a step-by-step

manner. Issues of communication between different softwares were considered and a solu-

tion was provided. Finally, the presented methodology is applied to a case study and some

encouraging preliminary results of the topology optimization, part design (smoothing and part

edition) and structural analysis stages are shown. The resultant design, compliant with the mass

constraint, shows good behaviour in terms of stress and stiffness considering structural require-

ments only.

5 Future Work

In the short term, the engineering cycle of the LLM needs to be concluded. At this point, the

engineering cycle of LLM considered structural requirements only. However, the work environ-

ment of an optomechanical part requires additional load cases and requirements. For instance,

mechanical loading due to I/F tolerances and thermo-elastic loading due to the mismatch of

thermal expansion coefficients. Finally, the process preparation and manufacturing campaign

stages need to be also concluded. Moreover, the presented methodology is still in development

and some key aspects are still missing. For instance, Ti6Al4V constitutive data (anisotropy,

porosity and strength data) is missing, which shall be obtained from the ongoing experimental

testing campaign. Additionally, fatigue testing campaign will be also performed in order to

evaluate the probability of failure during launch. Finally, AM manufacturing constraints need

to be added to the TO algorithm, namely the overhang constraints.
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